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� Visionary-T AP

Safety

	b Visionary-T AP does not constitute personal protection 
equipment in accordance with the respective applicable 
safety standards for machines.

	b The mounting, electrical installation and configuration of the 
device must only be carried out by professionally qualified 
personnel.

	b When mounting and electrical installation work is being car-
ried out, always comply with standard operating procedures, 
and applicable health and environmental regulations.

	b The device must not be used in outdoor or explosion-hazard-
ous areas!

	b When installing the device, always consider the electrical 
connected loads.

	b Replace faulty or damaged cables and male connectors 
immediately.

	b Replace damaged or faulty components immediately and in 
consultation with SICK AG.

	b When mounting the device, it is imperative that you use 
suitable mounting equipment and that you consider their 
specific tightening torques. The mounting equipment must 
be self-locking or secured appropriately.

	b Ensure a constant voltage supply to the device within the set 
parameters.

	b Operate the device only within the set operating parameters.

	b Regularly check that the device is functioning properly.

	b The infrared beams used pose no danger to the human eye 
if the device is operated within the prescribed parameters 
(optical risk classification 0, EN 62471).

	b Structural modifications to the device are strictly forbidden!

	b During mounting, ensure there are no attachment parts in 
the detection volume of the device.

	b The device must not be mounted behind a transparent 
screen since this will affect the system properties.

Scope of delivery

	b Visionary-T AP (3D sensor)

	b Quick start instructions

Note: API description, detailed product documentation 
and sample apps are available on  
supportportal.sick.com.

Product features

	b Working distance up to at least 10 m 

	b Meets industrial requirements for data reliability

	b 2-in-1: over 25000 depth values with integrated 2D live IR 
camera

	b Easy mounting and commissioning

	b 3D and 2D data collection with up to 50 fps

	b Visionary-T AP as configurable Key App enabler: in 
combination with Key Apps intended for users who want 
to solve specific application without developing their own 
software solution. 

	b Visionary-T AP as progammable device: intended for 
programmers, who want to develop vision applications 
based on Visionary data and run it directly on a device     

Overview

Visionary-T AP is a 3D and 2D sensor based on the time-of-
flight (ToF) principle. It provides real time 3D and 2D data at 
up to 50 frames per second (fps). 

SICK AppStudio development environment is required to run 
Visionary-T AP as programmable device (license required) 

SICK AppManager is required to run Visionary-T AP in combi-
nation with Key Apps as configurable device (license free)

To use the device, you need to follow the steps below:

1.	 Complete the mechanical and electrical setup.

2.	 Install and start SICK AppManager or AppStudio.

3.	 Connect the device to SICK AppManager or AppStudio.

4.	 Configure the device or start programming.

Mechanical and electrical setup   
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1.	 Fix the inner clamp to the outside edge (1). Attach the 
device (2) and secure it using the setscrews (3).

2.	 Prepare the mounting position in accordance with the 
dimensional drawing, see Appendix A.

3.	 Mount the device in the proper alignment for the 
desired detection volume. Ensure as far as possible 
that the detection volume is bordered by a flat 
boundary surface, see Appendix D.

4.	 Connect the Ethernet interface of the device directly to 
your computer or to the network to which your computer 
is connected.

5.	 Use the system plug of the device to connect the 
voltage supply and signal transmission, see Appendix C.

System requirements

Operating systems: 

	b Windows 10, 4 GB RAM, 

	b Windows 8 Professional (32/64 bit), 4 GB RAM

	b Windows 7 Professional (32/64 bit), 4 GB RAM

Min. Pentium i5, 2.6 GHz or comparable.

Free hard disk space: 450 MB.

Ethernet: 100 MBit/s or higher.

Additional GPU hardware may be required depending on 
visualization needs of the generated data.

Browser: Google Chrome (www.google.com/chrome) is recom-
mended due to advanced support of WebGL and WebSockets.

Installing SICK AppManager or AppStudio

The SICK AppManager is a configuration tool for installing and 
redeploying the Key Apps. The SICK AppStudio development 
environment is used to program the device. Administrator 
rights are required on the PC to install the software.

License

AppManager is a license free tool. The download and use of 
SICK AppStudio requires a valid license. A one-year-license 
can be purchased on www.sick.com (part number 1610199). 

Installation

1.	 Log in to the SICK Support Portal, supportportal.sick.
com. Registration of a user account is required before 
logging in for the first time.

2.	 Download the latest version of SICK AppManager or 
AppStudio.

3.	 Run the installer and follow the instructions on the 
screen. 

At the first use of SICK AppStudio, load or enter your personal license 
key to complete the installation. If the license dialog does not open 
automatically, open it by selecting License from the Help menu. SICK 
AppManager can be used directly after installation (no license key 
required).

Starting SICK AppStudio

1.	 Connect the device to the PC via Ethernet.

2.	 Set the PC to be on the same subnet as the device, but 
with a different IP address. The default IP address for 
the device is 192.168.1.10

3.	 Start SICK AppStudio. By default, the Connection wizard 
starts and scans for available devices.

4.	 Select the device in the Device list.

5.	 Click Connect.

Getting started withe the device

The Visionary-T AP has a pre-installed app called v3s140_2_
splitviewer, which shows a 2D intensity image and a 3D point 
cloud visualization. By default, the VisionaryViewer app runs 
as soon as the camera is powered on. The app can be used 
either with or without starting SICK AppStudio.

To open VisionaryViewer:

1.	 Open a web browser window. 

2.	 Type the IP address of the 3D sensor in the address 
field. The default IP address is 192.168.1.10

Views

The VisionaryViewer app has only one page with two viewers:

	b  2D viewer with an intensity image.

	b  3D viewer with a point cloud visualization.

Image handling controls

The image handling controls are used to scale, move, and 
rotate the 3D image in the viewer. As an alternative to the 
buttons, use the mouse shortcuts described below.

Button Name Description

Select Hover over a region to display the 
coordinates and corresponding pixel 
intensities. Click and drag to change 
the dimensions of the region of 
interest.

Move Click and drag to move the image.

Mouse shortcut: Press and hold Shift.

Rotate Click and drag to rotate the image.

Mouse shortcut: Press and hold Ctrl. 

Zoom Click and drag upwards to zoom in 
and downwards to zoom out.

Mouse shortcut: Use the mouse scroll 
wheel.

3D navigation control

Use the 3D navigation control in the lower left corner of the 
image viewer to change between orthographic 2D and 3D 
viewing angles:

	b Click an arrowhead (X, Y or Z) to view an orthographic 2D 
projection of the object.

	b Click the same arrowhead twice to flip the 2D projection, e.g. 
switch between the top and bottom view for the Z-axis.

	b Press Home to restore the default viewing position.
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Menus

The View, Color and Options menus in the 3D viewer contain 
options for visualization of the pointcloud data. 

Use X, Y, Z or Intensities from the View menu to select the 
different views for the data. 

Use the Color menu to choose the desired color of the 
gradient. 

Points from the Options menu displays the data with a point 
representation. Use the slider to change the size. Lighting and 
Surface are currently not used.

Using SICK AppStudio

Tutorials

Tutorials for general and device-specific topics are available to 
help the user get started with the programming of the device. 
The relevant tutorials for the Visionary-T AP are available on 
the SICK Support Portal, supportportal.sick.com.

Lua scripting

The embeddable scripting language Lua is used to create 
scripts in SICK AppStudio. See www.lua.org for more informa-
tion about Lua.

Auto completion

SICK AppSpace has a large API which includes functionality 
for hardware configuration, algorithms, result processing and 
result communication. The API is directly accessible from the 
Lua scripts:

1.	 Click a free place in the lua file. 

2.	 Press Ctrl+Space to display a list of all accessible 
functions and commands for the device.

The API documentation for the device is available on the SICK 
Support Portal, supportportal.sick.com.

AppStudio interface

Starting SICK AppManager

1.	 Connect the device to the PC via Ethernet.

2.	 Set the PC to be on the same subnet as the device, but 
with a different IP address. The default IP address for 
the device is 192.168.1.10.

3.	 Start SICK AppManager. By default the scan for 
connected devices starts.

Click a device in the Device list to connect. 

AppManager interface

Example of a Key App interface deployed by AppManager

Software licenses

SICK uses open-source software. This software is  licensed 
by the rights holders using the following licenses among 
others: the free licenses GNU General Public License (GPL 
Version2, GPL Version3) and GNU Lesser General Public 
License (LGPL), the MIT license, zLib license, and the 
licenses derived from the BSD license. 

The source code for these software components can be 
obtained from us on a data carrier within three years after 
distribution of the product (CD or DVD) by submitting a 
request to our customer service department at the following 
e-mail address: foss.compliance@sick.de 

This program is provided for general use, but WITHOUT 
ANY WARRANTY OF ANY KIND. This warranty disclaimer 
also extends to the implicit assurance of marketability or 
suitability of the program for a particular purpose. 

More details can be found in the GNU General Public 
License. View the complete license texts here: 
www. sick.com/licensetexts.

App 1 App 2

App 3

NFPA79 applications only.
Adapters providing field
wiring leads are available.
Refer to the product information.
Enclosure Type 1.
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� Connection power / digital inputs/outputs / service
� Device display
� Application display
� Ethernet status display
��Ethernet connection
� M6 blind tapped holes, 7�mm deep (2x), for mounting
� Service interface
� Optical axis
� Interface bracket
� Mounting bracket (accessories)
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B 

Device Description

Blue - flashing slowly System start
Orange - flashing slowly Device Warning
Red - flashing slowly Error state

Green Running / Ready

C 

Voltage/ digital I/O /service			         Gigabit Ethernet

M12 male connector, 	
17-pin system plug
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M12 female connector, 
8-pin X-coded
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Pin Signal Description Signal

1 GND Reference potential TRD0_P
2 24 V DC +/– 20% for 

integration times > 2.5 ms: 
24 V DC +/– 15%

Supply voltage TRD0_N-

3 CAN L Reserved, not executed. 
DO NOT connect to VCC!

TRD1_P

4 CAN H Reserved, not executed. 
DO NOT connect to VCC!

TRD1_N

5 TD+ (RS-422/485) Host) Reserved, not executed. 
DO NOT connect to VCC!

TRD3_P

6 TD– (RS-422/485) Host 
TxD (RS-232), Host

Reserved, not executed. 
DO NOT connect to VCC!

TRD3_N

7 TxD (RS-232), Aux Only service TRD2_P
8 RxD (RS-232) Aux Only service TRD2_N
9 SENS GND- Reference potential for 

electrically decoupled 
inputs

-

10 SENS IN1 Switching input, electrically 
decoupled

-

11 RD+ (RS-422 ) Host Reserved, not executed. 
DO NOT connect to VCC!

-

12 RD– (RS-422/485) Host 
RxD (RS-232), Host

Reserved, not executed. 
DO NOT connect to VCC!

-

13 INOUT 1 Programmable digital I/O -
14 INOUT 2 Programmable digital I/O -
15 SENS IN2 Switching input, electrically 

decoupled
-

16 INOUT 3 Programmable digital I/O -

17 INOUT 4 Programmable digital I/O -

D 
The detection volume of the device depends on:

	b the configuration;

	b the distance to a flat boundary surface, e.g., floor, ceiling, 
wall;

	b the mounting angle relative to the boundary surface.

The maximum detection distance – and therefore the 
3D detection volume – also depends on environmental 
influences such as:

	b lighting conditions

	b IR interference

	b air particle concentration

	b reflectivity (850 nm) of the objects in the detection zone

	b object transparencies (e.g., windows) 

NOTE	 The reliability of the detection is reduced by 
heavily reflective or absorbent materials (e.g., 
mirrors, black surfaces).Heavily reflective and 
shiny materials cause multiple reflections and 
lead to measurement errors (artifacts) due to 
the principle of operation.

Absolute accuracy and repeatability

Absolute accuracy (z-axis) and repeatability (central detec-
tion volume) at 100% remission and without background 
light for integration times of 1 ms (0.5 m and 1 m distance) 
and 4 ms (all other distances).

	

r max. 60 m

z max. 40 m

z 1

z 2

r 1

r 2

Abb. 1: Working distance, radial/absolute

Working distance 
radial (r)

Accuracy  
(100% remission)

Repeatability 
(1σ – 100% 
remission)

0.50 m ± 15 mm ± 2 mm
1.00 m ± 15 mm ± 2 mm
2.00 m ± 15 mm ± 2 mm
3.00 m ± 15 mm ± 3 mm
4.00 m ± 20 mm ± 3 mm
5.00 m ± 25 mm ± 4 mm
7.00 m ± 35 mm ± 7 mm
10.00 m ± 50 mm ± 15 mm
15.00 m ± 50 mm ± 30 mm
20.00 m ± 50 mm ± 50 mm

Working distance 
radial (r)

Accuracy  
(10% remission)

Repeatability 
(1σ – 100% 
remission)

0.50 m ± 15 mm ± 2 mm
1.00 m ± 15 mm ± 3 mm
2.00 m ± 20 mm ± 6 mm
3.00 m ± 35 mm ± 10 mm
4.00 m ± 50 mm ± 20 mm
5.00 m ± 50 mm ± 25 mm
7.00 m – –
10.00 m – –
15.00 m – –
20.00 m – –

	

Δx

Δy

z

Abb. 2: Detection volume and 2D ranges

Working distance 
absolute (z)

Range (Δx) Range (Δy)

0.50 m 0.70 m 0.53 m
1.00 m 1.40 m 1.06 m
1.50 m 2.10 m 1.60 m
2.00 m 2.80 m 2.13 m
3.00 m 4.12 m 3.19 m
4.00 m 5.50 m 4.25 m
5.00 m 6.87 m 5.32 m
10.00 m 13.75 m 10.63 m
15.00 m 20.62 m 15.95 m
20.00 m 27.49 m 21.27 m
40.00 m 54.98 m 42.54 m
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Visionary-T AP
Working distance 0.5 m ... 60 m
Detection angle 69° x 56°
Example field of view 7 m x 5.3 m
Pixel count 176 x 144 pixels
Repeatability ≥ 2 mm, at a range of 1 m; ≥ 7 mm, at a range of 7 m1

Light sensitivity < 50 kLux (sunlight)
Connections M12 17-pin (voltage supply), system plug digital IOs (24 V)

M12 8-pin Gigabit Ethernet, X-coded
Supply voltage 24 V DC; (+/–20%), < 2.5 ms integration time; (+/–15%), > 2.5 ms integration time
Power consumption ≤ 22 W typically (without digital I/Os)
Peak current 3 A
Mounting height variable
Mounting position variable
Weight 1.4 kg, without cooling fins; 1.9 kg, with cooling fins
Dimensions (L x W x H) 62 mm x 93 mm x 78 mm, without cooling fins

162 mm x 116 mm x 104 mm, with cooling fins
Ambient temperature (operation) 0 °C ... +45 °C, without cooling fins; 0 °C ... +50 °C, with cooling fins

The maximum operating temperature is reduced by 5 °C in speed mode.
Ambient temperature (storage) –20 °C ... +70 °C
Shock resistance According to EN 60068-2-27:2009
Vibration resistance According to EN 60068-2-6 and 60068-2-64
Electromagnetic compatibility (EMC) EN 61000-6-2:2005-08; EN 61000-6-2:2005-08
Protection class III
Enclosure rating IP67
LED class Risk group 0 in accordance with EN 62471

1  See tables for individual values

F 
Optional accessories

Part no. Description Part no. Description
2077709 2x screws, 2x clamps 6051194 M12 cable, 2A, Ecolab, 3 m (CDB650)
2077710 Mounting kit (2-part) incl. clamps 2070425 M12 cable, 2A, Ecolab, 3 m
6049728 Ethernet cable 2 m, M12 / RJ45, X-coded 2070426 M12 cable, 2A, Ecolab, 5 m

6049729 Ethernet cable 5 m, M12 / RJ45, X-coded 1064114 CDB650-204, Split Box

Dimensional drawings in mm (inch)

LED definitions

Pin assignment

Detection volume

Technical data

Optional accessories


